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What's New With This Release
This topic provides you with an overview of the new features and functions in Data Manager.
New Feature/Functionality

Description

More flexibility

The Data Manager is a flexible configuration with the following
advantages:

Advanced tool

l

Interfacing to AQUIS Operation and TERMIS Operation.

l

OPC is not tied to Data Manager.

l

Multiple OPC connections.

l

Source specific TEMPdb.

Data Manager caters to processes such as preprocessing, data
checks and data emulation.

SQL Server

The SQL Server back-end option has been subject to a redesign to
meet and comply with new Microsoft standards.

Connection types

As of this version there is support for the following connection
types
l

OLE DB

l

OPC (entirely new setup using DM OPC)

l

External

l

Algorithm

As External and DAIO sources are considered identical there is no
longer support for the latter source.
Restart process cycle

You can automatically shut down Data Manager when you need to
restart your running process.
For details see How To: Restart a Running Process (Cycle), page
17.

Convert Microsoft Access data-

You can then convert your Microsoft Access database to run on

base to SQL Server Express

SQL Express. For details see How To: Convert Microsoft Access
Database to SQL Server Express, page 45.

Viewing the online Help:
The assumption is a minimum resolution of 1024 x 768 pixels.
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Introduction to Data Manager
Data Manager is a standalone online database application for configuring, preprocessing, and administering raw data
from any data source such as supervisory control and data acquisition (SCADA) systems and Data Loggers. The data can
subsequently be used in a real-time scenario in conjunction with the 7-Technologies product suite.
Data Manager is used to:
l

Receive data from any data source such as SCADA systems, Data Loggers, etc.

l

Perform data conversion, data checks, and data emulation for data received. These processes are performed by
the data preprocessor.

l

Maintain cyclic buffers of week profiles for selected SCADA tags.

l

Make the preprocessed data available for online simulations (real-time and historical).

l

Automatically backup historical data.

Product highlights
Feature

Description

Validation checks

Check to see if received measurements are within a certain range
or rate of change.

Data substitution

Substitute facility measurements by emulated values.

Storage of historical values

Historical values are stored for use by

Reduced values

l

Historical simulations (simulation of what happened within
a given period).

l

The load forecast.

l

Debug of events.

l

Cross-checking.

Create reduced values of measurements as average values, minimum values, maximum values, etc.

Math values

Create new virtual measurements based on other measurements
via addition, subtraction, multiplication, etc.

Data Manager cycle period
Data Manager works in a cyclic manner executing SQL statements for each defined data tag. The cycle period is typically
between 2 and 15 minutes, depending on the actual setup. The tags are updated first according to source index and second according to tag index.
To secure updated measurements before start of a simulation the recommended period is half the time defined under
Interval for Preprocessing. For details see Run Menu, page 58.
The period can be shorter if Data Manager is used to produce average values for the model or for the load forecast module.
The following figure illustrates how Data Manager interacts with external units, modules, and programs.
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Explanation to the figure…
Notice that there is no risk of sharing violations as each application has a dedicated database where the results are
stored.
Module

Description

SCADA

Any SCADA system with an OPC, ODBC, ADO, or ASCII based interface.

AQUIS (Operation)

An advanced and powerful water network simulation platform.
The program is designed to improve hydraulic performance, water
quality and safety of operation, while reducing water supply costs,
leak risks, non-revenue water, capital investment and support
time.

TERMIS (Operation)

An extensive district energy network simulation platform designed
to improve network setup, operation, and energy consumption. At
the same time, the program can contribute to reducing energy
costs, operating costs, capital investments, and support time.

DM OPC

The default OPC tool supplied with Data Manager that you can use
when applying the OPC connection type for data transfer.
For details see About DM OPC Interface, page 73.

External

Connection type. For details see About Data Sources, page 21.

OLEDB

Connection type. For details see About Data Sources, page 21.

Leakage Management

The results from the Leakage Management system are stored in
the LMDB.

TempDB

This is a default database supplied with the product. You can
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Module

Description
decide to use your own database. However that database must
have exactly the same structure as the TempImp.
Data Manager supports source specific TempImp. The default database is configured to match the version of legacy (old) TERMIS or
AQUIS or Operations respectively.
TempImp: Select this if you are running legacy (old) TERMIS or
AQUIS.
TempImp3: Select this if you are running Operations.

Load Forecaster

The Load Forecaster provides forecast based on data from legacy
(old) TERMIS and TERMIS Operation. The results are stored in the
Load Forecaster database.

OnlineDB

This is the Data Manager pre-configured database.

ASCII

ASCII text file with all or selected measurements. As an example
the file can be exported to another Data Manager installation for
import or via 7TWatchDog to a Control Center for detailed status
information.

Next
l

Perform initial configuration setup. For details see About Preferences - Initial Configuration, page 10.

l

Add or edit Data source. For details see About Data Sources, page 21.

l

Add or edit Data Tags. For details see About Data Tags, page 24.

l

Configure the communication setup depending on the selected connection type. Choose from the list of data
source types:
- OPC (Note: Entirely new connection setup as of V2.1)
- OLE DB
- External
- Algorithm

For optimal performance you are recommended to use the OPC connection type to send data to a SCADA system as the
OPC is standard setup for most SCADA systems. The use of other connection types depends on what the appropriate
SCADA system supports.
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Before You Begin - Workflow
The following is an overview of the logical steps you take when you start working in Data Manager. Each step in the
workflow is described in-depth in the documentation.

Installation
You have received all information in regards to installation from our Web site. The assumption is that you have installed
Operations prior to Data Manager.

Define Preferences
Before you start the actual configuration, such as for data sources and data tags, you are recommended to define the
global preferences. For details see About Preferences - Initial Configuration, page 10.

Configure
The configuration of Data Manager involves the setup of data sources and data tags. as well as the connection types;
for example OPC. For details on configuration you are recommended to peruse the table of contents for this documentation.

Perform test run
You are recommended to perform a test run of the preprocessor once you have configured all the non-algorithm tags.
For details see Run Menu, page 58.
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About Preferences - Initial Configuration
Before you start the configuration of Data Manager to run with associated software, such as Operations, IGSS SCADA
system, or a third-party program, you must define a set of general parameters. This initial setup is performed under the
Preferences submenu. The parameters under the Preferences menu are for example system log, auto start, default
substitution rules, and historical data and backup definitions.
This topic only describes the key parameters. Your system, however, may require additional configuration.

To open the Preferences dialog
l

From the Configure menu select Preferences.

The dialog opens in the General tab pages. You must configure all the tab pages as described in the ensuing sections.
General tab page options…

Option

Description

System log

The log file is stored in the working folder. Define the folder under the
entry Working directory.
Enable

Select this check box to activate system logging.

Basic

Logging only errors.

Intermediate

Tracing code modules.

Detailed

Tracing data/preprocessor.
It can be useful to select the Detailed logging option for extensive systems if you
experience system behavior irregularities.
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Option

Description
Detailed logging is not recommended for
regular operation as it slows down the system performance considerably.

System restore

Log file size

Enter the accepted file size in MB.

Autostart all proc-

Select this check box to restart the pre-

esses

processing cycle after a reload.
Subsequently you must select the restart
method.

After unauthorized

Restarts the pre-processing cycle, if Data

shutdown

Manager terminates abnormally; for example in case of power outage.

Auto start delay

Enter the delay in seconds.

After Data Manager

Restarts Data Manager with the same

restart

option settings as before Data Manager was
closed.

Data Manager only restores automatically if you have
added a shortcut to Data Manager under Windows
Startup.
l

Editor

On the Windows task bar select Start, point to All
Programs, then 7T, and then Data Manager, and drag
Data Manager to Startup. under All Programs.

Enter the name of a text editor used to access the system log.
Notepad is the default text editor.

Work directory

Enter the location of your working folder or locate the working folder
using the browse button.
By default Data Manager creates the following work folder C:\Temp\

Preprocessor tab page…
Each data preprocessor cycle evaluates the raw data by performing a series of checks on raw status and raw value. The
preprocessed value is returned together with a data preprocessor status that reflects the quality of the preprocessed
measurement. For details on the flow for the data preprocessor see Appendix H: Data Preprocessor Flow, page 118.
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Option

Description

Historical data

Under the Other tab page in the dialog Data Tag Details you configure how to save historical data for the individual tags. For the Preprocessor tab page under Preferences select Store historical data
to save historical data for those tags.
If you regret clearing the Store historical data check box on
the Other tab page for one or more tags, you can now decide
to save historical data for all tags. Select Check all to save historical data for all tags or Clear all to avoid saving historical
tag data.

Default $LastTime

Define a default time for preprocessing the SQL statement: "$LastTime" for the first time. Select one of the options

ASCII dumps

l

Start of day

l

Start of week

l

Start of month

This option is typically used if you forward data through ftp or mail to
another location.
Write raw data to

Select this option to make Data Manager

ASCII file

save raw data to an ASCII file. Enter a file
name or locate a file using the browse but-
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Option

Description
ton. The file is overwritten for each preprocessing cycle.
Write preprocessed

Select this option to make Data Manager

data to ASCII file

save DPP (preprocessed) data to an ASCII
file. Enter a file name or locate a file using
the browse button. The file is overwritten
for each preprocessing cycle.
This option is used if 7TWatchDog is used to
transmit data from Data Manager to any
ftp location. For details see 7TWatchDog .

Arithmetic mode

Real-time

Algorithms are calculated based on latest
received system time and actual values.

Historical

Algorithms are calculated point-wise correctly, based on the history of the involved
time series starting from the last processed
value until newest value including all measurements in between.

OPC

Auto start local OPC

Select this option to make the DPP (data

Client

preprocessing) start the local OPC Client.

Executables tab page…
You must define whether you want to execute the file(s) before or after each preprocessing cycle. Configure the areas
Pre-executables and Post-executables according to the guidelines in the following table. The configurations performed
under The configurations under this tab page apply when you create Data Sources.
Select Enabled box for each file to enable the settings for that particular file.
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Option

Description

File

Enter the file name or locate the file using the browse button.
Specify any executables that need to be activated before and/or
after each DPP (data preprocessing) cycle.
You should use a bat file, or the like, if more than two executables
need to be activated.

Argument

Add program specific parameters, which will be used when the relevant file is executed.

Wait for process to finish

Select this option to indicate that the preprocessor will temporarily
stop until the executable has completed.

Halt on errors

This option is only intended for debugging or error tracking on the
system.

Backup tab page…
To prevent poor performance and loss of data you can set Data Manager to perform an automatic backup of the database in a compressed format, and reset the current database. To include less historical data and as the database is not
available during file compression, the preprocessor will temporarily stop during the backup process.
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Configure the tab page according to the definitions in the following table.
Option

Description

Automatic <database> backup

Select this option if you want Data Manager to perform an auto-

enabled

matic backup of the active database.

Backup directory

Enter a folder name or locate the folder using the browse button.

Backup interval

Select one of the three options to set a relevant backup interval.
The automatic backup is conducted according to the backup interval and the process is as follows:
l

MS Access backup
The active database is copied to the backup folder and then
compacted and renamed by adding a unique time stamp to
the file name.
The active database is then reduced by deleting all history
older than the individual tag history setting plus the historical overlap. The active database is then compacted.

Moreover, the option And if the database reaches [XXX] MB
ensures backup action if the database exceeds the defined database size. This feature does not overrule the other backup settings, but simply creates an extra backup when reaching the
specified limit.
Historical overlap

Define how many days you want Data Manager to keep the active
database. When you perform a backup of the database, or reset
the history, only data that goes back further than the number of
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Option

Description
days specified is deleted.

Daily compact

Select this option to run a database compact every midnight.

For details see Appendix G: SQL Substitution Rules, page 116.

- 16 -

Data Manager, Setup Guide

How To: Restart a Running Process (Cycle)
If you need to stop a running Data Manager process you can send a command line parameter to deactivate Data Manager.
l

Open a command prompt (cmd.exe) and enter the path to the Data Manager installation followed by the following command line parameter
\dm.exe -SHUTDOWN or
\dm.exe /SHUTDOWN
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Navigating Data Manager
Data Manager operates on the basis of a Microsoft SQL Server or a Microsoft Access database, where the latter is the
default solution.
The following figure shows the Data Manager interface and provides an outline description of each interface element.

where
1

Menu bar

From the menu bar you can get access to all features and functions through a number of sub menus and commands.
For details see the ensuing section on Menu overview.

2

Toolbar

The toolbar contains a number of buttons for shortcut access to
the most commonly used features and functions. For details see
Appendix J: Toolbar Buttons and Shortcuts, page 121.

3

Work area

In the work area you will see the dialogs that you open by selecting the toolbar buttons or the menu commands.

4

Information window

The information window displays general static information about
the current configuration.

5

Status bar

The status bar at the bottom of the screen displays general information about database and system status.

Menu overview
Menu

Description

File menu

The File menu enables you to
l

Create new databases.

l

Open existing databases.

l

Import data to database.
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Menu

Configure

Description
l

Export from the existing database.

l

Clear the database history.

The Configure menu contains commands for configuring data
sources, data tags, cyclic buffers, and definitions of default database settings. This topic provides a description of all these areas.
From this menu you can change and modify the settings within
the following items

Run

l

Data sources

l

Data tags

l

Cyclic buffers

l

Preferences

The Run menu explains how to configure the dialog for the Preprocessor and running processes.
For details see Run Menu, page 58.

View

The View menu explains how to configure the display for tables
and graphs in Data Manager.
For details see View Menu, page 60.

Tools

The Tools menu explains how to set the options for resetting and
initializing values.
For details see Tools Menu, page 69.

Window

The Windows menu provides additional system display options
(Windows standard display settings).
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About Data Sources
Data sources define the data communication for Data Manager. All tags are assigned to data sources. Typically, there is
one data source for the following exchange of data:
l

From SCADA to Data Manager.

l

To read a load forecast or a meteorological forecast to Data Manager.

l

For arithmetic functions and reductions to Data Manager.

l

Transfer of data from the Operations applications to SCADA.

Data Manager supports four connection types. See the list under options in the ensuing table. There are no limitations
to the number of sources of each type as long as the name is unique. This topic provides an overview of the general functionality of data sources whereas each of the connection types will be described in-depth in separate sections.
Processing order for data sources:
1. By Source Index.
2. By the Data Source name if several sources have identical source index.

To add a new data source
1. From the Configure menu select Data Sources.
This opens a dialog that displays all the defined data source.

2. To add a new connection type select the button Add New. This launches the following dialog.
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The light-blue area within the dashed frame will show different options depending on the connection type.
3. Create the data source based on the information in the following table.
Explain options under Data Sources dialog…
Option

Description

Name

Enter a name for the connection type. The new connection will be
listed on the initial Data Source page.
Select the Active check box to enable Data Manager to include
this source and all tags in the preprocessing.

Connection type

You must define different parameters depending on the connection type that you select for the data source. There are no limitations to the number of sources of each type as long as they
have unique names.
Choose among the list of supported connection types.
Each connection type is explained in details in separate
topics. See the table of contents.
l

OPC

l

OLE DB

l

External
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Option

Description
l

Algorithm

Select the Active check box for the connection type to extract
new data from the source.
If you clear the check box the preprocessing reuses the previous
received measurements in the new cycle.
UTC check box

Select this check box if data in the data source is logged in UTC
(coordinated universal) time, else local time will apply.

Source index

The source index defines the preprocessing order of the sources.
The sources are first processed based on the index setting, and second on the source name. If there are multiple sources with identical indices the source name determines the preprocessing order.
Sources set to index 0 are processed first, then index 1, etc.
Select the Active check box for the source level to activate preprocessing of all tags in the data source.
See also Run Menu, page 58.

Pre-executable
Post-executables

Determine whether to execute the external applications before
(pre-) and/or after (post-) the tags in the source are preprocessed.
By default the preprocessor pauses while the external application
is executing.
Select and configure these files under the Executables tab page
under the Preferences menu.

Pre-arguments
Post-arguments
Comment

You can add arguments before (pre-) and/or after (post-) the processing cycle.

Add a text description for easy identification.
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About Data Tags
When you have defined the data sources in a configuration, the next step is to add and configure data tags in the data
sources.
Processing order for data tags:
1. For data tags inside each data source by Tag Index (defined under the Other tab page).
2. If several tags have identical tag indices, then by the tag name.

Import or export of data
You have the option to import or export data tags or data as time series to use for further processing in DM. For details
you rare referred to the following topics:
Import Data, page 51
Export Data, page 55

To open the Data Tag dialog and add new
1. From the Configure menu select Data Tags.
This opens the Data Tags dialog.

2. Select Add New and enter configuration information for the tag following the explanation provided in the ensuing table.
Explain high-level information fields…
Option

Description

Tag name

Enter a name for the new tag. There is a limit of 80 characters.

Source

Choose one of the data sources from the list. For details see About
Data Sources, page 21.

Parameter

Choose a parameter from the list.
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Option

Description
Parameters should not be modified as the data processing then may fail.

Status

Choose a status for the data tag from the list.
Used directly

The tag is used as defined.

One default used

The first point for the tag is generated using
the system time and the default value as
specified under emulation. The status is
then automatically changed to used.

Not used

The tag is not processed.

Always emulate

The settings under the tab pages Extract,
Conversion, and Check are skipped, and
only Emulation settings apply to the tag.

3. Now configure each of the tab pages under the Data Tag dialog as explained in the following sections.
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Extract tab page options…
Option

Description

None

This option is always available.
If selected, anything specified under the Extract tab page is
ignored, and the most recent data set is used repeatedly.

SQL

This option is available for OLE DB, OPC, and External data connection types with an SQL statement as specified under the
Extract tab page. A default SQL statement can be overruled by
anything specified in the tag specific Extract tab page.
To build the correct SQL statement it can be useful to use
"SELECT * FROM TABLE" together with the test button in
several iterations.

Arithmetic / Reduction

These two options are available only for the Algorithm connection
type. Data Manager can then perform mathematical calculations
using all other tags.
For details see description under the Option tab page and Appendix C: Arithmetic Expressions, page 103. The appendix contains a
complete list of allowed arithmetic expressions and operators.

Selecting Arithmetic option
The arithmetic option is illustrated in the following figure. It displays how to add the measurements from two tags and
how to store the result in the arithmetic data source. Tag names under Arithmetic must be enclosed in square brackets
[ ]. When arithmetic expressions are calculated, the individual tags will be replaced by the latest preprocessed value. The
result is used as a raw value for the arithmetic tag, and you can then perform configurations as for normal tags, for
example data conversion.
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Selecting Reduction option
You can decide to perform a data reduction. There are three types of available reduction expressions.
Expression

Syntax and Definition

Comments

TSAvg

TSavg(['Tag'], 'Period', 'Time Assignment')

Used to calculate average or

Time series of the tag reduced to average values using
equidistant time series.

extreme values at fixed times,
for example every full hour,
every half hour, or every 10
minutes (at nice rounded time
intervals).
This method is called static
reduction.

TSMin

TSmin(['Tag'], 'Period', 'Time Assignment')
Time series of the tag reduced to minimum values
using equidistant time series.

Used to calculate an average
value at the preprocessing time
for a defined interval (period)
while retrieving data for a certain time interval back in time
(time assignment).
This method is called dynamic
reduction.
Example:
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Expression

Syntax and Definition

Comments
TSrun([Tag], '60', '30') where
you in 30 minutes will run a 60
minute interval.

TSMax

TSmax(['Tag'], 'Period', 'Time Assignment')

Same as for TSMin.

Time series of the tag reduced to maximum values
using equidistant time series.
TSRun

TSrun(['Tag'], 'Period', 'Time Assignment')

Same as for TSMin.

Running average of the tag.
These reduction functions will each create a time series, in which the time interval equals the 'Period' for the selected
'Tag'. 'Time Assignment' values are "L", "C" and "R", which indicate if the reduced data time tag will be justified left,
center or right of the reduction interval.
For TSRun the Period is the time interval (back in time period) and the Time Assignment is a value
for the period ahead of time.
The following figure displays the data reduction TSmin([q1],5,C). This expression creates a time series with five minute
intervals starting at midnight. Data is reduced to one value only every five minutes, in this case to the minimum value.
The reduced value is then added to the time stamp in the center of the interval. If an interval does not contain a value,
the preceding reduced value will be reused.
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Conversion tab page options…
You can convert raw data from any data source directly to another unit. Configure the values for Factor and Offset.

Option

Description

Conversion type

When you use difference or difference ration conversion, the tag
must be initialized:
1. Under the Status field select One default used.
2. Under the Emulation tab page define a default value.
Normal

The most common setting.
The new extracted value is used directly as
raw value.

Difference

The raw value is generated as the difference between the new extracted value
and the previous value.

Difference ratio

The raw value is generated as the difference between the new extracted value
and the previous value, divided by the time
(in seconds) between the two.

Cyclic maximum

The maximum value of a cumulative
meter, the value where the meters revert
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Option

Description
to zero.

Data conversion

You are recommended to convert data to SI units.
The raw value is converted according to the following syntax:
V

=Factor x V

DPP

RAW

+ Offset
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Check tab page options…
When you have converted the data as described in the preceding you can configure data checks.

Option

Description

Range

The converted value must be within the specified limits.

Change

The difference between the newly converted value and the previous value must be within the specified limits.

Rate of change

The difference between the newly converted value and the previous value divided by the time (seconds) must be within the specified limits.

Age

The difference in time (minutes) between the time stamps of the
newly converted value and the previous value must be less than
the value specified.

Notice the following option behaviors:
l

If you select the Active check boxes for any of the options, data will be emulated, if any of the checks fail.

l

The Percentage check box will be ignored if the basis value for the check is set to 0 (zero) as this value leads to a
division by zero errors.

The converted measurement that is either accepted or emulated is referred to as the DPP (Data Preprocessing) value.
See Appendix I: Data Flow (for Data Tags), page 119 for an overview of the data flow in connection with data checks.
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Emulation tab page options…
You must select the appropriate Active check box to enable the required emulation method.

Option

Description

Default value

Measurements are substituted by a default value that remains
constant.
The specified default value is used as a DPP (data preprocessing)
value.

Average value

Under Period enter the value to be used for calculating the average.
The DPP value is generated as the running average of the previous
n (period) DPP values:
V

=1/n*V +(n-1)/n*V

AVG, n

n

AVG,n-1

where
V

AVG

is new average.

n is the period to be included in a running average value.
V is new measurement.
n

Reference tag value

Measurements are substituted by the converted measurement
from another tag selected from the Tag list. The tag selected from
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Option

Description
the Tag list is also converted directly.
The DPP (data preprocessing) value is generated using this value
as the reference tag for the corresponding point in time, and
according to the values defined for factor and offset.

Buffer value

The DPP (data preprocessing) value is taken from the selected
buffer from the corresponding point in time.

Skip value

The data point is altogether ignored.

If no emulation is defined, the faulty value is still used as DPP (data preprocessing) value. However, the measurement
will be assigned a special DPP status.
See Appendix I: Data Flow (for Data Tags), page 119 for an overview of the data flow in connection with data emulation.
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Other tab page options…

Option

Description

Historical data

Use this option to save data to a database and make it available for
other applications as historical time series data.
Store historical data

By default this setting is activated.
To save historical data for the current tag you must also select the
check box Save historical data
under the submenu Preferences.
To locate this option select Configure >Preferences>Preprocessor.

Storage Interval

When you save a historical data point, the
time difference (minutes) from the last
saved data point must be bigger than this
value; else the data point is ignored.

Storage period

When you create a backup (for example
using Microsoft Access) the ensuing cleanup of the active database will delete history
older than this value (days).
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Option

Description
If the backup is enabled for a Microsoft SQL
Server database, the Microsoft Access
backup will be created containing history
encompassing this period.
Store data in pack-

Select this check box to keep an exact copy

ets

of the data packet.
The option can be used for data in a time
series (record sets/packets) that needs to
be used individually. Historical data is
stored in one time common line. This
makes it impossible to distinguish the
individual time series received.
For example, the packet options allow you
to store two different load forecasts
received with a time span of one hour, without mixing the values that cover the same
time.

For a data point with an existing time stamp, the new measurement
will overwrite the previous measurement. Use the data packet
option to keep a copy of such a sequence.
Data insert mode

This option only applies when data is received as a time series.
Merge

For time series saved as historical data, the
data is merged with existing historic data
for the same period.

Replace

For historically saved time series, existing
historical data for the same period is
deleted.
In regards to extracting data it is important
to configure this option to avoid having old
values be present in the new forecast.

Algorithm options

Only available for tags defined with an algorithm connection type.
There is currently only support for the setting Density period.
This setting will only generate algorithm data points if the data
points behind the tag exist within a limited timeframe. The setting
behavior depends on the algorithm type as described in the ensuing
table.
See the figure in the ensuing after this table.

- 35 -

Data Manager, Setup Guide

Option

Description
Arithmetic

A data point is only generated if all involved
tags have a valid measurement with a time
mark within a certain time frame. The time
frame is defined as the period that starts at
the specified Density period prior to the
actual time, and ending at the actual time.

Reduction

A data point is only generated if there are
valid measurements with a time mark right
before and after the reduction period.
The Density period defines the time frame
added to the reduction period (both ends)
that defines the check interval.

Index

Source

Displays read-only processing information
on source (index level).

Tag

Specifies the processing order for the tags
within the source.

Coordinates

Enter the appropriate coordinates for the tag. These coordinates can
be ported to a layer in Operations and used in the current project.

Send to OPC

Select the check box for Update client if you want the DPP (data
preprocessing) value from a tag to be available for the Data Manager
OPC Client and make the following settings:
a. Select the source.
b. Select the tag (alias).
Example

See also the topic How To: Send Data From Data Manager To SCADA
Using DM OPC, page 79.
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This figure illustrates specific time stamps for data points (first graph) and reduction points generated for reduction periods (second graph).
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About Cyclic Buffers
This topic provides background information on the handling of cyclic buffers. For a hands-on description see How To: Configure Cyclic Buffers, page 39.
A cyclic buffer is a time series that covers exactly one week and is dynamically maintained by the data preprocessor. For
details see Run Menu, page 58. The time series is made up of time tags of identical intervals, for example one hour.
When enabled, the preprocessor maintains all enabled buffers by updating the minimum, maximum, and average
value, and where the time tag corresponds to the actual time. A buffer can contain any number of added or subtracted
SCADA tags to be maintained as a uniform time series. If you define a historical period in weeks, the buffer tags are calculated based on minimum, maximum, and average values over this period. You can define a historical offset; for example a historical period of 2 and a historical offset of 3 will go 3 weeks back in time and then use the 2 weeks before that to
calculate the buffer. A buffer is typically used to calculate an average value of the net flow to a supply zone in a supply
system creating a weekly profile of demand.
When you create a data source based on an OLE DB connection type, Data Manager needs to know where data comes
from. You are recommended to study the following topic for further information, How To: Send Data from DM to SCADA
Using OLE DB, page 86.

Evaluation of cyclic buffers
A time interval is located based on actual preprocessing time plus an offset and a period from this point.
At this interval the average is calculated and assigned to the preprocessing time.
This situation is illustrated in the ensuing figure.
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How To: Configure Cyclic Buffers
This topic explains how to configure the settings under the Cyclic Buffer window. For background information you are
referred to the topic About Cyclic Buffers, page 38.

To open the Cyclic Buffers dialog
l

From the Configure menu select Cyclic Buffers.

Under the Cyclic Buffers dialog you have the following editing options

To select buffer
l

Under Buffer name select a name from the list.

To add new buffer
l

Click New and enter a name for the new buffer. The buffer is added to the list under Buffer names.
Proceed to the configuration of the buffer, following the explanation of the options in the ensuing table.

To rename buffer
l

Click Rename to write a new name for the buffer.

To create buffer template
l

Click Copy As to create a copy of the existing buffer.
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Explain cyclic buffer options…
Option

Description

Buffer container

This option encompasses a list of all the SCADA tags to be added or
subtracted in the current buffer.
l

Double-click (toggle) a tag in the list to change the sign for the
tag.
+ adds the tag value to the buffer.
- subtracts the tag value from the buffer.

Remove selected

Select this option if you want to delete a tag

tags from buffer

from the current buffer container.
To remove multiple tags hold down the
CTRL key and selected the required tags.

Select tag to add to

Select this option to add a SCADA tag to the

buffer

current buffer container. Select the
required tag and click Add.

Buffer settings

Under the Buffer settings you can define the settings for the time
series intervals as well as for an average historical period and a historical buffer.
If you define a historical period in weeks, the buffer tags are calculated based on minimum, maximum, and average values over this
period. You can define a historical offset; for example a historical
period of 2 and a historical offset of 3 will go 3 weeks back in time and
then use the 2 weeks before that to calculate the buffer. A buffer is
typically used to calculate an average value of the net flow to a
supply zone in a supply system creating a weekly profile of demand.

Status

Select this check box to enable the buffer and make the buffer time
series reinitialize when closing the buffer configuration.

Comment

Add a description to further identify the buffer.

The following table provides information on actions behind some of the buttons.
Buttons

Description

Apply

Select this button to save changes to the buffer without closing
the dialog.
When you click Apply the action(s) cannot be
undone.

Delete

Select this button to remove all information from the Cyclic Buffers dialog.
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Buttons

Description

Initialize

Select this button to initialize the current buffer.

Close

Select this button to save changes and close the dialog.

Cancel

Select this button for any regrets. The dialog will close and none of
the changes will be saved - unless you have previously clicked
Apply.

Reset

Restore the original buffer settings.
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New Database
You can decide to create a new database from either Microsoft Access or Microsoft SQL Server. Data Manager comes
with a Microsoft Access database and as such this access is used as the default format for creating databases.
Microsoft SQL Server is not supplied with Data Manager and requires that you purchase a legal copy of the software.
However, you can choose to use the free downloadable Microsoft SQL Server 2008 R2 Express. You can find it from this
Web site (both 32-bit and 64-bit): http://www.microsoft.com/express/Database/ (Last accessed April 2011).
You can then convert your Microsoft Access database to run on SQL Express. For details see How To: Convert Microsoft
Access Database to SQL Server Express, page 45.

To create new database using Microsoft Access
1. From the File menu select New Database and point to Access.
2. In the dialog for New Database enter the file name for the database.

To create a new database using Microsoft SQL Server
1. From the File menu select New Database and point to SQL Server.
2. Under the dialog for New Database enter the file name for the database.

3. Under SQL Server select a server from the list. Use the correct username and password.
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You will then see the following dialog

4. Select Create to open the dialog Create Database.
5. Enter a database name and click OK.

The new database is now listed in the dialog Create Database on [database name]. Select Close to exit the
dialog.
To create a new database for SQL Server you need the proper access rights. Contact your system administrator for this information.
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Existing Database
You can access any of your databases from the File menu.
If you choose to open an existing database in an SQL Server you will need read and write rights on
the specific database. Contact your system administrator for details.

To open an existing Microsoft Access database
1. From the File menu select Open Database and point to Access.
2. Under the dialog for Open Database select the appropriate database.
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How To: Convert Microsoft Access Database to SQL Server Express
Microsoft SQL Server is not supplied with Data Manager and requires that you purchase a legal copy of the software.
However, you can choose to use the free downloadable Microsoft SQL Server 2008 R2 Express. You can find it from this
Web site (both 32-bit and 64-bit): http://www.microsoft.com/express/Database/ (Last accessed April 2011).

Before
When you have installed the Microsoft SQL Server Express following the guidelines provided with the software, you can
start the process of converting the Microsoft Access database to an SQL Server Express database. Notice that the conversion process applies to newer versions of Microsoft Office.

To convert a Microsoft Access database
1. Open the relevant Microsoft Access database and from the menu bar select Database Tools and under Move
Data (ribbon) select SQL Server. Press Next.

2. From the drop-down menu select the relevant SQL Server, for example use the default name SQLEXPRESS. The
server name can also be a localhost. In that case the syntax must be .\<server name>.
3. Select the check box for Use Trusted Connection.
4. Enter a name for the new SQL Express database. Here TestSQL. Press Next.
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5. Under the ensuing dialog select the tables to export to SQL Server Express. Select the button >> to move all
tables from the Microsoft Access database. Press Next.

6. Configure the parameters that you want to upsize following the guidelines in the ensuing, and press Next when
done.
Select the following check boxes
l

Index

l

Validation rules

l

Defaults
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l

Table relationships

l

Use DRI

Under Add Timestamp fields to table select No, never.

7. In the ensuing select the check box for No application changes and press Next , then Finish (when the application has all pertinent information) to complete the conversion process.

8. Finally, open the SQL Server database. From the menu bar select Open Database and point to SQL Server.
9. Under the Provider tab select Microsoft OLE DB Provider for SQL Server.
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10. Under the Connection tab select the server name (for example .\SQLEXPRESS) and select the check box for
Use Window NT Integrated security .
11. Select the database you created earlier on (in this example TestSQL) and save the changes.
This completes the conversion process and you can start using the SQL Server Express database in Data Manager.
Remember to also change the Data Manager connection in Operations.
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Compact or Shrink Your Database
You can reduce the size of your database by removing unused pages.
You cannot reduce the database while you are preprocessing.
You can only reduce a database to the point where it has no free space remaining, and the size of the database cannot
be smaller than the size when it was created.
l

From the menu bar select File and then Compact Database.

Result
For Microsoft Access database: Compact and Repair.
For Microsoft SQL Server database: Shrink
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Reset History
You can reset the history of the database if so required.

To reset history
1. From the File menu select Reset History.
2. Under the dialog Data Manager you can select Yes to accept a backup of database files before resetting.

The backup is created according to a normal backup as described under the dialog Preferences.
The backup database and the original database are both compressed during the process.
Backup is only applicable when saving Microsoft Access databases.
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Import Data
You have the option to import tags and time series to Data Manager.

Tag configuration
You can import SCADA tag names and configurations from an ASCII file into the currently active database. The ASCII
file with the SCADA definitions must be configured as described in Appendix A: Data Configuration File, page 100.

To import tag configurations
1. From the File menu select Import and point to Tag Configurations.
2. Under the dialog for Import Tags point to a file that has SCADA tag definitions and click Import.

If the current database is empty, the file will automatically be imported to the configuration.
If the database is not empty, you can specify the following parameter:
l

Select the check box Overwrite existing tags to update all tags in the database with data from the ASCII file.

Time series
You can import measurements from an ASCII file to the historical section of the database. The ASCII file containing the
measurements must have a format as described in Appendix B: Historical Data File, page 102.

To import time series
1. From the File menu select Import and point to Time Series.
2. Under the dialog Import Time Series make the appropriate configurations according to the definitions in the
ensuing table.
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Explain time series import options…
Option

Description

Import rules

Define Start time.
Under Start time, only data with time tags time stamped after the
start time will be imported. If left blank, the start time of the
import is equal to the first time tag in the ASCII file.
Define End time.
Under End time, only data with time tags time stamped before the
end time will be imported. If left blank, the stop time of the import
is equal to the last time tag in the ASCII file.
Define Import interval.
Under Import interval, you can specify the time interval in minutes between data groups. If import interval is undefined, the
time tags generated in the database will equal those from the
import files. If an import interval is specified, the time tags within
the database will be generated from start time to end time with a
time interval equivalent to the import interval.
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Option

Description
Select Include preprocessor if you want data during import.
That is, you want to perform a check of data and subsequently
emulate data.
For details see About Preferences - Initial Configuration, page 10.
If you select the Import button at this point, the system will start
the data import from each selected ASCII file.

Scheduler

Under Scheduler Settings you can define a schedule to run a
daily import at defined time intervals. When you have defined up
to four time intervals, select the Schedule button to close the
dialog and start the Scheduler. On the information bar below the
dialog, notice how the status of the TSI Scheduler has changed to
display the time for the next interval.

If none of the Active check boxes is selected, the TSI Scheduler
will as default display Off.
Import of time series can lead to data groups with different
numbers of measurements in each data group. All data groups will
contain measurements from all SCADA tags only if each SCADA
tag has a measurement at each time tag.
File settings

Under File settings make the appropriate selection for the following options.

Files to import

l

List separator.

l

Decimal sign.

l

Date separator.

l

Date format from the lists.

You can import more than one file at a time, but the
files must be located in the same folder.
From the top list select the appropriate drive on your computer.
From the folder structure locate the files to import.
Select a file extension from the list at the bottom.
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Option

Description
When you select the file extension you will see a list of files in the
preceding pane. Select the files to import by holding down the
CTRL key.
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Export Data
You have the option to export tags and time series from Data Manager to external applications.
This topic explains how to export data using the File menu item. There is an alternative export feature tha allow you to
export facility all tags as an ascii file. The system does not export tags from inactive sources or tags marked "Not used".
For details on this options see the explanation for ASCII dumps under the topic About Preferences - Initial Configuration,
page 10.

Tag configuration
You can export a complete list of configured SCADA tags within the current database to an ASCII file.

To export tag configurations
1. From the File menu select Export and point to Tag Configurations.
2. Under the dialog for Export Tags point to a file that has SCADA tag definitions and click Export.

The procedure for exporting a complete list of configured SCADA tags within the current database to an ASCII file is identical the procedure importing SCADA tags as described in the preceding. See also the example under Appendix A: Data
Configuration File, page 100.

Time series
You can export historical data for a user defined selection of SCADA tags.

To export time series
1. From the File menu select Export and point to Time Series.

- 55 -

Data Manager, Setup Guide

The format of the exported file is similar to that of the import file as described in the preceding, except that only
one SCADA tag is included in each export file.
2. Under the dialog for Export History point to the files with the SCADA tag definitions and click Export. For multiple files hold down the Ctrl key.
3. Select the Export button and browse for a folder in which to place the export files, and click OK. The export files
will be saved with the same names as the SCADA tags and with the extension .csv.
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Export Microsoft Access Database
You have the option to export the entire configuration as a Microsoft Access database whether you are running on a
Microsoft Access database or a Microsoft SQL database.
l

From the menu bar select File and then Export Access Database.

You can choose to include historical data with the export, but this can impact the performance as the export process
then includes all types of history, buffers, data packages, event logs, etc.
When you opt to include historical data you are prompted to select an interval. When you select the check box Select
All then all defined time steps within the given interval are included in the export process.
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Run Menu
This topic explains how to configure the dialog for the Preprocessor and start running a process.
You are recommended to perform a test run of the preprocessor once you have configured all the non-algorithm tags.

To open the dialog Run Preprocessor
l

From the Run menu select Preprocessor.

Option

Description

Interval

Specify the interval (in minutes) between each preprocessing
cycle.
If you set the time to 0, the preprocessor will run only once when
enabled.
If the numerical value is followed by an s, Data Manager will interpret the interval as seconds. If the number is a negative, the preprocessor will run with no delay between the preprocessing cycles.

Start at

Select the check box Start at to activate the preprocessor with a
delay.

Status
When the preprocessor is running, you will see a status window with process details about the running process. Moreover, the status windows shows statistical information of the overall preprocessing history. .
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You will not be able to exit Data Manager when the preprocessor is running.
The Preprocessor is started and stopped from the Run menu or the associated icon
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View Menu
This topic explains how to set the display for tables and graphs in Data Manager.
The View menu contains the following options that can be customized according to needs and requirements:
l

Measurements

l

Historical data

l

Data graph

l

Buffer graph

l

Event log

l

System log

Measurements
This dialog displays a simple table of all active SCADA units with the latest received raw measurements and the corresponding preprocessed values.
The measurement table is automatically updated after each preprocessing cycle, and when you press the Refresh button.

To open the Measurement dialog
1. From the View menu select Measurements.
This opens the Measurements dialog.

2. Under Data Source select the relevant item from the list. Proceed to the list of measurement options.
Select a column header once or twice to sort the column data in ascending or descending order.
Explain measurement options…
Option

Description

DM Tag

Select a tag name for the selected unit.

Source

This is the name of the data source .
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Option

Description

Parameter

The parameter defined for the data tag.

Log Time

The time stamp for the raw data.

Raw value

The values from the OPC server.

Raw status

The status of the raw data. For details see the code definitions in
the ensuing under the section Legends.

Dpp time

The time stamp for the data preprocessing data.

Dpp value

The values from the OPC server.

Dpp status

The status of the Dpp data. For details see the code definitions in
the ensuing under the section Legends.

Legends

View additional information on value and status for raw and Dpp.
For details see the code definitions in the ensuing under the section Legends.

Apply Filter

Select a cell and then Apply Filterto only display data entries with
this specific text or value.
Example
o Under the Parameter column, select a cell that contains

the parameter Pressure. Select Apply Filter. Now you
only see data entries that pertain to Pressure under the
Parameter column.
Filter off

Select Filter off to disable the filter.

Historical data
If you store historical data within the database, this data can be displayed under Historical Data. Data is displayed chronologically in groups listing the oldest first. The dialog includes several options to limit the number of rows displayed

To open the Historical Data dialog
l

From the View menu select Historical data and under Tag select the relevant data tag.
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Explain historical data options…
Option

Description

DM Tag

Select a tag name for the selected unit.

Source

This is the name of the data source .

Parameter

The parameter defined for the data tag.

Log Time

The time stamp for the raw data.

Raw value

The values from the OPC server.

Raw status

The status of the raw data. For details see the code definitions in
the ensuing under the section Legends.

Dpp time

The time stamp for the data preprocessing data.

Dpp value

The values from the OPC server.

Dpp status

The status of the Dpp data. For details see the code definitions in
the ensuing under the section Legends.

Legends

View additional information on value and status for raw and Dpp.
For details see the code definitions in the ensuing under the section Legends.

Data period

Select one of the options to define the list of historical data to be
displayed.
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Option

Description
l

Select Day to see data 24 hours back in time.

l

Select Month to see data a month back in time (that is 30
days of 24 hours).

l

Select User defined to define your own settings.
Define a time interval by typing date and/or time values in
the Start and End boxes.
You must use the format yyyy-mm-dd hh:mm; for example "2011-10-30 08:30".

Filter

Narrow the list of historical data even selecting options from the
Data source and Parameter lists.
Click Apply to enable a filter and click Reset to undo the selection
(s).

Legends
The Raw status legends and the DPP (data preprocessing) status legends provide you with detailed OPC server numerical code information. Each data preprocessor cycle evaluates the raw data by performing a series of checks on raw
status and raw value.

OPC server numerical codes
You can see the detailed numerical codes in the database for the OPC server. The following table shows some of the
most commonly seen codes when the type for Data Source in Data Manager is set to OPC. The list is in no way exhaustive, and for details on the numerical codes you are referred to the documentation provided with your OPC.
View numerical codes…
~ in Data Manager
Code

Code Meaning

See Legends following this table

0
64
192
4

The value is bad, but no specific reason is known.

30

There is no specific reason why the value is uncertain.

30
0

The value is good.
There is a server-specific problem with the con-

20

figuration.
8

The input is required to be logically connected to some-

30

thing but is not.
12

A device failure has been detected

30

16

A device failure has been detected

30
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~ in Data Manager
Code

Code Meaning

See Legends following this table

20

Communications have failed. However, the last known

30

value is available.
24

Communications have failed. No last known value is

30

available.
28

The block is off scan or otherwise locked.

30

68

The last usable value.

30

80

Either the value has reached one of the sensor limits

30

(in which case the limit field should be set to 1 or 2) or
the sensor is otherwise known to be out of calibration.
84

The returned value is outside the limits defined for this

30

parameter. Note that in this case, the limit flag indicates which limit has been exceeded.
88

The value is derived from multiple sources and has less

30

than the required number of good sources.
216

The value has been overridden. Typically, this means

30

the input has been disconnected and a manually
defined value has been forced.

Data Manager display of OPC codes
The numerical codes for the OPC server are interpreted into the following main status information in Data Manager
under Legends.
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For any other values than 0 you should stay alert to your processes to make sure that you have a
running system.
View DM interpretation of OPC codes…
Data Manager
status

Description

Raw data legends
- 20

SCADA tag not found.

0

Measurement OK.

10

Measurement not updated.

20

Manually inserted.

30

Measurement not valid.

Dpp status legends
-10

Tag not evaluated.

0

Measurement accepted.

10

Measurement emulated.

20

Measurement not emulated due to no emulation configured.

Data graph
Data Manager can plot graphs based on the historical time series of tags.

To open the Data Graph dialog
l

From the View menu select Data Graph.
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Explain data graph options…
Option

Description

Tag

Select a data tag to plot.

Plot period

Define the list of historical data to be displayed.
l

Select Day to see data 24 hours back in time.

l

Select Month to see data a month back in time (that is 30
days of 24 hours).

l

Select User defined to define your own settings.
Define a time interval by typing date and/or time values in
the Start and End boxes.
You must use the format yyyy-mm-dd hh:mm; for example "2011-10-30 08:30".

Include

Select if you want the graph to display DPP (data preprocessing)
data, Raw data, or DPP and Raw data.

Filter

Narrow the list of historical data even selecting options from the
Data source and Parameter lists.
Click Apply to enable a filter and click Reset to undo the selection
(s).

Navigation tips for data and buffer graph
l

To enlarge a specific part of the graph, click and hold down the mouse button and drag the cursor to select the
area you want to enlarge.

l

Right-click the graph to display a shortcut menu.

l

Double-click the graph to open the Customization dialog. This dialog contains the same features that you find
when you right-click the graph.
Under the Customization dialog select Export to open the dialog Exporting <tag name>.
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Explain Export options…
Option

Description

Export Destination

Specify the file format.

Object Size

Specify the size of an object.

When you have completed the definition click Export, or click Cancel to close the dialog box without exporting.

Buffer graph
This type of graph is not as commonly applied as a data graph. For editing hints see the explanation under the Data
graph.

To open the Buffer Graph dialog
l

From the View menu select Buffer Graph.

Event log
All events that are generated within Data Manager and considered relevant for the operator are stored in the event log.

To open the Event Log dialog
l

From the View menu select Event Log.
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Double-click a row under the Event Log dialog box to open the detailed Event Viewer.
Under the Event Viewer, you can copy events to the clipboard and print and delete events.
Click Previous and Next to see the various events.

System log
A system log can be generated on request via the general property page on the Preference dialog.
All system log entries are stored in the system log as a .txt file. This log is mainly used when you track system errors or
inconsistencies.
You are highly recommended to disable the system log after use, as this file can be huge and may
cause the system to stop.

To open the System Log dialog
l

From the View menu select System Log.
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Tools Menu
Under the Tools menu you have the option to reset or initialize values.

Reset values
Option

Description

Average values

When the preprocessor is running, it maintains average values for
each individual tag on the basis of the amount of data specified on
the Check tab in the Data Tag Details dialog box. You can reset calculation of average values by using this feature for resetting the
values.
l

Under the Tools menu point to Reset, and select Average
Values to delete all average values.

This option can be used if the system has been restarted and you
want to reload the average values that are currently running.
Cyclic buffer

Remove the current cyclic buffer values.

Initialize values
Setting

Description

Cyclic buffer

Initialize cyclic buffers.For details see About Cyclic Buffers, page
38.

Algorithm tags

Initialize the tags defined for the algorithm connection type.
For details on this type see About Algorithm, page 92.
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About DM OPC
This topic explains the basics of the use of the DM OPC and provides pointers to the configuration of a DM OPC data
source in Data Manager.
The concept of OPC (OLE for Process Control) is all about open connectivity in industrial automation. OPC standards are
specified and maintained by the OPC Foundation. For details see www.opcfoundation.org (last accessed July 2010). OPC
includes 7 standards (active or planned) where OPC Data Access (OPC DA) is the original and first used to exchange realtime data between SCADA systems and external applications/clients. OPC DA can be used for I/O communication, and is
the most commonly used of the OPC protocols. Data Manager supports OPC DA.
The principle of communication is that an OPC Server makes data available from a data source. In the ensuing illustration this is from the SCADA system, IGSS. The DM OPC then connects to the OPC Server and maps the required available data tags. Communication is subsequently event driven and there will be notification and updates as soon as a
change occurs. Once you have established the DM OPC connection, it is possible to collect and retrieve data from various
sources to be used in Operations as well as old (legacy) TERMIS and AQUIS for real-time simulations.
For optimal performance you are recommended to use the OPC connection type to send data to a SCADA system
as the OPC is standard setup for most SCADA systems. The use of other connection types depends on what the
appropriate SCADA system supports.

Assumptions - or: Before your begin DM OPC configuration
Before you start the configuration of the DM OPC application you must ensure that you observe the following:
l

DM OPC and OPC Server must be installed on the same machine.

l

OPC Server and SCADA (for example IGSS) must be properly configured and running when you start the DM OPC
configuration.

l

Basic knowledge of OPC concepts.

l

IGSS is used as the sample SCADA system in the documentation.

DM OPC graphical overview
The illustration in the ensuing shows the data flow when you use OPC as the connection data type in Data Manager.

- 70 -

Data Manager, Setup Guide

Explain modules and databases in the preceding figure…
The following table lists the modules and databases used for the DM OPC communication.
Module / Database

Description

Data Manager

Online database application for configuring, preprocessing, and
administrating raw data.
The present documentation provides in-depth configuration information.

Data Manager database

Standard Data Manager database.

DM OPC

With the DM OPC application you can subscribe to SCADA tags.
A Microsoft Access database contains the DM OPC configuration.
The configuration database is automatically updated using the DM
OPC configuration CSV (comma separated values) file.

OPC Server

The OPC Server is a SCADA application that allows the DM OPC to
subscribe to SCADA tags.
The OPC Server and the DM OPC application must be
installed on the same machine (as illustrated in the
figure).
The OPC Server provides a list of tags that can be selected and
assigned to a Data Manager tag name. You can edit this tag name
if required for easy identification.
Your SCADA system provider must inform you of the
appropriate OPC server name. Tag names are supplied with the OPC module.
In addition, to complete the OPC Server setup you must perform a
proper configuration of the DCOM (Distributed COM) component.
The DCOM is an integral security mechanism in the Windows operating system. It operates as a network extension of the component object model (COM) technology that enables interprocess
communication across network.
If you use IGSS as your SCADA system you are referred to the documentation provided with IGSS. You will find in-depth description
of DCOM and OPC Server configuration. For details see the online
help named IGSS Interface Help.

SCADA

Supervisory Control & Data Acquisition.
This is your preferred application for gathering and analyzing real
time data. This documentation assumes that you are running
IGSS as your preferred SCADA system. However, the configuration guidelines for the DM OPC application can apply to any
SCADA system.
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For details on DCOM
The OPC Foundation provides a number of white papers and articles (PDF format) in regards to DCOM security.
l

OPC and DCOM White Papers (Web site last visited March 2011)
http://www.opcfoundation.org/Downloads/White%20Papers
Select Downloads then White Papers>, and point to either OPC, DCOM and Securit or OPC, DCOM and
Performance Issues.

Next
You have the option to use DM OPC to send and receive data between your preferred SCADA system and the Data Manager.
Proceed to one of the following topics to establish a successful DM OPC communication.
How To: Send Data From SCADA To Data Manager Using DM OPC, page 75
How To: Send Data From Data Manager To SCADA Using DM OPC, page 79
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About DM OPC Interface
This topic explains the contents of the DM OPC interface.
To send and receive data you are referred to the following topics:
l

How To: Send Data From SCADA To Data Manager Using DM OPC, page 75

l

How To: Send Data From Data Manager To SCADA Using DM OPC, page 79

Explain DM OPC menu bar and right-click menu…
Menu

Menu Contents

Menu Description

File

New configuration

Select this menu to create a new configuration. The
configuration is stored in a file with the extension .csv.

Open configuration

Select this menu to open an existing configuration
(saved as a .csv file.

Server

Import CSV

Use these menus to perform manual edits of large

Export CSV

chunks of data.

Exit

Save changes and exit the application.

Connect

Establish a connection to an already running OPC
Server.

Disconnect

Disconnect the connection to a running connection to
an OPC Server.

View

Log

View basic information on the data transmission activity.

Help

About DM OPC

Displays the current software version of the DM OPC.

Explain DM OPC right-click menus…

Left pane

Menu

Menu Description

Reconnect

Select this menu to reestablish the connection to the
required server.

Disconnect

Select this menu to cancel the connection to the
server.

View Status

View the status of the server and additional information on the server, such as vendor information,
start time and current time, etc.

Right pane

Edit Group

Point to the required tag and perform edits on the
group level. You can only edit a few of the options,
such as the name and the update rate.

Edit DM Name

Point to the required tag and change the alias name if
you want a name that is different and easier to identify
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Menu

Menu Description
than the default OPC name.

Remove Tag

Point to the tag you no longer need to remove it from
the list of selected tags.

Remove All Tags

Remove all the previously selected tags.

For background information see About DM OPC, page 70.

- 74 -

Data Manager, Setup Guide

How To: Send Data From SCADA To Data Manager Using DM OPC
This topic provides guidelines for the setup of sending data from your preferred SCADA system via the OPC Server and
the DM OPC to Data Manager as illustrated in the following figure.
For background information see About DM OPC, page 70.

Before
l

Your SCADA system and OPC Server must be properly configured and up and running.

l

Ensure that the DM OPC and the OPC Server are installed on the same machine.

l

It is assumed that you are familiar with the basic OPC concepts and that you have a running and well-configured
IGSS and OPC Server.

The communication setup encompasses the following steps that are explained in the ensuing sections:
A. Configure DM OPC
l

Create new DM OPC configuration database.

l

Connect to SCADA server. (This documentation uses IGSS as the sample SCADA system.)

B. Configure Data Manager
l

Create and configure data source in Data Manager.

l

Create and configure data tag in Data Manager.

When you have completed the setup you must validate that you have a running connection as explained in the topic
How To: Validate Data Communication Using DM OPC, page 81.
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Step A: Configure DM OPC
The DM OPC uses a Microsoft Access database to store both configuration and real-time state (data). The DM OPC automatically loads the configuration saved in the file with the extension .csv and starts the event driven data exchange.
l

Open DM OPC.
If you installed to the default folder you can (in Vista) launch it from Start>All Programs>7T>Data
Manager>DM OPC.

To create new database and connect to server
1. From the DM OPC menu bar select File, then New and locate the relevant Microsoft Access database.
2. From the menu bar select Server, then Connect and under the dialog Select Server point to the required
server.
In the right-most pane you can see a list of all available objects.
3. Optional. If you want to rename one of the objects, such as for easier identification, right-click the appropriate
object and select Edit DM Name. Edit the Alias name as appropriate.

Any changes in the SCADA system are now reflected in the DM OPC; this could for example be the open/close status of
valves.

Step B: Configure Data Manager
This step provides guidelines for the setup of Data Manager so that you can use the DM OPC as a tool for direct inspection of the state of the running system.
l

Open Data Manager.
If you installed to the default folder you can (in Vista) launch it from Start>All Programs>7T>Data Manager.

To configure Data Manager data source
l

Create a new Data Source and as minimum configure the following parameters:
For details see the description for Data Sources under the topic About Data Sources, page 21.
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Option

Description

Name

Enter a relevant name for the new data source.

Connection type

Select OPC as the connection type.

OPC Client DB

Point to the database that you created in the DM OPC.
Under Default SQL you will see the connection string that defines
where to retrieve data from.

Sample Data Source figure

All data sources of the communication type OPC automatically point to the current DM OPC and communicate
with its configuration database.
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To configure data tags
For details see the description for Data Tags under the topic About Data Tags, page 24.
l

Follow the instructions in said topic to create a new Data Tag an as minimum configure the following parameters:
Option

Description

Name

Enter a relevant name for the new data tag.

Source

Point to the Data Source you created in the preceding.

Sample Data Tag figure
If you changed the alias name under the DM OPC this change is reflected in the column DM Tag in the data tag
dialog.
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How To: Send Data From Data Manager To SCADA Using DM OPC
This topic provides guidelines for the setup of sending data from Data Manager to your preferred SCADA system via the
OPC Server and DM OPC as illustrated in the following figure. (Notice that this documentation uses IGSS as the sample
SCADA system.)
For background information see About DM OPC, page 70.

Before
l

Your SCADA system and OPC Server must be properly configured and up and running.

l

Ensure that the DM OPC and the OPC Server are installed on the same machine.

l

It is assumed that you are familiar with the basic OPC concepts and that you have a running and well-configured
IGSS and OPC Server.

The communication setup encompasses the following steps that are explained in the ensuing sections:
A. From DM OPC, select required tags.
B. From Data Manager, associate with the Data Tag that contains data.
When you have completed the setup you must validate that you have a running connection as explained in the topic
How To: Validate Data Communication Using DM OPC, page 81.

Step A: Select tags in DM OPC
l

Under the DM OPC application you must select all the object tags that you need for your data exchange. Point to
the relevant object in the left-most pane to display the tags in the right-most pane.
Update the alias name to the preferred tag name used in Data Manager, if required.
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Step B: Point to data tag in Data Manager
Under the Data Manager application you must select the tag that holds the relevant data.
1. Open the relevant Data Tag and select the Other tab page.
2. Under the Send to OPC entry (lower right corner) select the check box Update client. This allows the transfer
of a value from Data Manager to SCADA.

3. In the first drop-down list (a) select the relevant OPC data source, here Test_DMOPC.
4. In the second drop-down list (b) select the relevant OPC tag (alias), here IGSS_Server Status Configuration, and
select Apply.
To set up multiple OPC clients, repeat step B for as many clients you want to set up.
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How To: Validate Data Communication Using DM OPC
When you have completed the communication setup for sending data between your preferred SCADA system and Data
Manager you must validate that you have a running connection.
1. From the Data Manager menu bar select Run and then Preprocessor and select Start to initiate the preprocessing process.
2. Check communication: Cross check the data communication between SCADA and the Data Manager (view measurements).
A typical error is conflicting tag names between Data Manager and the DM OPC.
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About OLE DB
This chapter describes the basics of OLE DB (Object Linking and Embedding Database) and provides pointers to the configuration of an OLE DB data source. The OLE DB encompasses ODBC drivers. The OLE DB data source is a database with
an existing OLE DB Provider. Data Manager uses SQL to extract data from the source database. You must specify the
SQL statement as the database schema is unknown to Data Manager.
For a hands-on description of how to retrieve data you are referred to the topic that explains how to connect to a SCADA
system that supports OLE DB. In the sample description the SCADA system is IGSS. See How To: Get Data From SCADA
System (IGSS) To Data Manager Using OLE DB, page 83. Connecting to a SCADA system that uses OLE DB is the same
for all systems that support these methods. The differences appear in the table structure in which the OLE DB Provider
presents the SCADA database, and the extent of SQL that is implemented in the OLE DB Provider.
When you look at databases that do not have their own user interface for browsing and editing, it is recommended to
use Microsoft Access and the linked table functionality. This allows Microsoft Access to display and browse the contents
of most databases that can be accessed using OLE DB.
When you connect to a SCADA database it is recommended to check the product documentation for
details on the table structure and parameters to ensure that you extract the correct data.
The OLE DB connection type applies when the data source is a database that can be accessed via ActiveX Data Objects.
If you can extract data for all tags using a generic SQL statement, you can define this statement on data source level
rather than on tag level.
In this context notice that the OLE DB Provider from Microsoft for Access databases is named Microsoft Jet 4.0 OLE DB Provider.
The default SQL added on data source level is not generic and as such it is necessary to perform manual corrections for
each tag in the data source. For details see the ensuing sections on SQL substitution rules and SQL data and time formats.
For details see Appendix G: SQL Substitution Rules, page 116.

Next
Proceed to the following topic to establish a successful OLE DB communication.
How To: Get Data From SCADA System (IGSS) To Data Manager Using OLE DB, page 83
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How To: Get Data From SCADA System (IGSS) To Data Manager
Using OLE DB
This topic provides a step by step description of how to establish an OLE DB communication with a SCADA system using
SQL SELECT statements on a database and subsequently send data to Data Manager. For background information see
the topic About OLE DB, page 82. The following explanation assumes that the OLE DB connection is made to an IGSS
SCADA system, hence the reference to specific tables in the IGSS system.
To specify a generic SQL statement for all tags in the data source it can be useful to define several data sources in
Data Manager that point to the same source.
You will learn how to
l

Configure data source that points to IGSS ODBC database and all required data tags.

l

Send data from IGSS to Data Manager using the OLE DB connection type.

Before
1. Install IGSS (or open you SCADA system). The example in this topic is based on IGSSV8. There is support for V7
using a different driver.
2. Ensure that the following services are running:
l

IGSS ODBC Server

l

IGSS Starter

To configure data source to point to SCADA database
1. From the menu bar in Data Manager select Configure and then Data Sources and select Add New.
2. Under Name enter an appropriate name for the new data source.
3. Under Connection type select OLE DB.
4. Under Connection string specify the link to the database under the dialog Data Link Properties. The following instruction applies to an IGSS connection. The database can be any kind of database supported by the
OLE DB provider available on your PC.
a. Select Microsoft OLE DB Provider for ODBC Drivers.
b. Under the Connection tab select Use data source name and select IGSS32v8 ODBC Network DS.
c. Test the connection and exit the Data Link Properties dialog.
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5. Under Default SQL specify a default SQL statement to be used as basis for the individual tags. You can use the
SQL substitution rules to specify a generic SQL statement. The topic About OLE DB, page 82 contains a section
on SQL substitution rules and SQL date and time formats.

To prepare for data transfer from IGSS to Data Manager
1. Select Add tags to DM to automatically add tags from source database to Data Manager.
2. Point to the IGSS database table called ATOM_ONLINE. This action loads and displays the contents of the table.
You may want to limit the number of tags to display, for example to 100 tags.
3. Under the dialog Auto Configure Tags select Filter to create a proper filter; for example AREA='Global' AND
ATOM=0.
Remember to add the single quotation marks for text parameters.
In IGSS each object has several atoms that represent different values of the object such as process value, set
point, low alarm, high alarm.
4. Under Tag name enter for example [ENAME]. This is the unique column name of any object.
You must enter the tag name between square brackets.
5. Select Apply Filter.
6. In the revised list of tags highlight the tags you want to create for Data Manager and select Build Tag.
7. Verify the tag names and select Add Tag. This will add the tags to the source in Data Manager with the name
specified under the column DMTAG and the default settings.
The following figure shows the contents of the table ATOM_ONLINE in IGSS that contains the real-time values of
all tags in IGSS.
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Extract OLE DB tags
When you create an OLE DB data source it is not obvious to Data Manager from where data is extracted.
In general it is possible to specify a default SQL statement that can be used to extract data for all tags in the data source.
This typically requires a 1:1 relation between the tags in the data source and Data Manager.
You can specify a default SQL statement when you connect to the IGSS system using the ODBC interface and extract
online data from the ATOM_ONLINE table. Follow the steps under the section in the preceding to specify a default SQL
statement.
The ensuing figure shows a sample default SQL statement and where the DM tag is TestPump.

A default SQL statement can always be overruled by a tag specific SQL statement, if required.
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How To: Send Data from DM to SCADA Using OLE DB
The following description is an alternative to sending data from Data Managerto SCADA. In general, you are recommended to use the OPC connection to send data from Data Managerto SCADA. For details see About DM OPC, page
70.
Data Manager does not support the return of SQL UPDATE data to SCADA. This task must be performed manually using
an external application such as a VB Script.
Add to this that not all SCADA systems allow the sending of data to SCADA from external application in which case an
OPC server, if available, may be an option. Your SCADA system may be equipped with a feature to read data from an
external source, and if that is the case the SCADA administrator must configure the system to retrieve the data from
Data Manager.
In IGSS it is possible to send data to a SCADA tag by updating the value in the ATOM_ONLINE table. The ensuing figure
shows an example of a VB Script file.
See sample VB Script file - TransferDMData.dbs file…

s
The VB Script in the preceding figure can be used as a template for other systems. To activate one or more VB Script files
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after the normal pre-processing cycle, list all the VB Scripts in a batch file (a text file with extension bat) as shown in the
ensuing figure.
See sample bat file - PostRun.bat…

Subsequently, configure Data Manager to execute the bat file after each cycle to transfer the newest data extracted
from sOperationsto SCADA. See the figure for an illustration.
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About External Communication
The External connection type is used for data sent to Data Manager by an external application without any action or control made from Data Manager. The external application can be either be Operations or a SCADA system, with no support
for OPC or OLE DB.
Your SCADA system may be equipped with a feature to read data from an external source, and if that is the case the
SCADA administrator must configure the system to retrieve the data from Data Manager.
Where Data Manager receives data and/or sends data, the transfer of data happens via a data source that uses a template Microsoft Access database that defines the correct format.
The data source is a temporary database where other systems can deliver data to Data Manager. Data Manager uses
SQL to extract new data from the template database, or to store data in the template database. You are recommended
to use a default SQL statement. Data Manager comes with two temporary databases:
l

TempImp2 for single values only

l

TempImp3 - also supports time series. The Operation suite uses TempImp3.

If you installed to the default folder you will find the sample databases under C;\Program Files\7T\Data Manager 2.0\Templates.
You cannot define parameters for data sources using this connection type.

Next
Proceed to the following topic to establish a successful External communication.
How To: Send Data from Operations to Data Manager Using External Connection Type, page 89
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How To: Send Data from Operations to Data Manager Using External Connection Type
This topic explains how to configure Data Manager to receive data results from Operations. For TERMIS Operation this is
executed with special focus on the Temperature Optimization process. It is assumed that you have working knowledge
of Microsoft Access for the work with the databases. For background information you are referred to About External Communication, page 88.
The following are typical output results from the temperature optimization process:
l

Optimal supply temperature at each plant.

l

Next day production.

l

Age of latest simulation.

The ensuing figure illustrates the flow of results from Operations to Data Manager.
The results are ported via a digital object to Data Manager. For details on digital objects and how to define the data
export you are referred to the documentation provided with Operations.

From Data Manager the data from Operations can be sent to any SCADA system using an OPC client connection or External connection. For in-depth information on OPC communication see How To: Send Data From SCADA To Data Manager
Using DM OPC, page 75.

To configure Data Manager to receive Operations data
1. In the Operations application ensure that you have a correct configuration of a digital object. See the Operations
documentation for details.
2. From the menu bar in Data Manager select Configure and then Data Sources and select Add New.
3. Under Name enter an appropriate name for the new data source.
4. Under Connection type select External.
5. Under TempImp DB point to the correct database.
You can create a new TempImp DB using the sample databases supplied with the product or use the supplied
database as is (recommended). If you installed to the default folder you will find the sample databases under C:\Program Files\7T\Data Manager 2.0\Templates.
Use TempImp3 for Operations.
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To reduce the risk of access violations consider creating a specific TempImpDB for each external data source.
6. Under Default SQL use the standard SQL statements as used by Data Manager to extract data. You should only
change this statements if special needs and demands require this.
For TempImp3 you are strongly recommended not to change the SQL statement as this may
prevent a proper connection.

7. Select Add Tags to DM to automatically add tags from source database to Data Manager.
8. Under the dialog Auto Configure Tags select the query table named qryTags. This action loads and displays the
contents of the table.
9. Under Filter you can apply a filter, if needed. In general this does not apply to External data sources.
10. Under Tag name define for example [TagID].
You must enter the tag name between square brackets.
In the TempImp2 database the tag name is available in the field ScadaID.
11. Select the rows that contain the tags you want to be configured in Data Manager and select Build Tags.
12. Verify that the tag names are correct and select Add Tags. This will add the tags to the source in Data Manager
with the name specified under the column DMTAG and the default settings.
The ensuing figure shows the adding of two AQUIS Operation tags.
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Data Manager automatically deletes records from External data sources after they have been read.

Extract external tags
When you create a data source based on the external connection type, Data Manager automatically adds a default SQL
statement. There is one SQL statement for each of the two default databases, TempImp2 and TempImp3.
You are recommended to use the built-in SQL statements for external connection types as this ensures correct performance when you preprocess data tags for data sources.
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About Algorithm
The Algorithm connection type can be considered an internal data source as the calculation using general arithmetic formulas and specific reductions is done on tags that already reside within Data Manager.
You cannot define an algorithm on source level, as arithmetic expressions are entered on tag level.

Next
Proceed to the following topic to establish a successful algorithm communication.
How To: Set Up Algorithm Connection, page 93
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How To: Set Up Algorithm Connection
This topic provides guidelines and pointers to allow the use of the algorithm connection type. This type of connection is
used to calculate arithmetic expressions or perform reductions on tag level.
You may want to create an algorithm data source that corresponds to similar calculations and reductions to create
a logical grouping of the calculations tags.
1. From the menu bar select Configure and then Data Sources and select Add New.
2. Under Name enter an appropriate name for the new data source.
3. Under Connection type select Algorithm.
Notice how the connection string defaults to the database you selected under the File menu .
4. Under Source index specify the required processing order of sources. Algorithms are typically used on tags
imported from other sources and therefore needs to be updated last, or at least in a specific order.

5. Additional setup of the algorithm connection type must be done under the Data Tags dialog.
Under the data tag dialog you must select either the Arithmetic or the Reduction option. For in-depth description see under the Extract tab page in the topic About Data Tags, page 24.
Appendix C contains a complete list of allowed arithmetic expressions and operators.
Consider creating a specific algorithm data source for similar calculations and reductions to make a logic grouping
of the calculations tags.
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Extract algorithm tag - Arithmetic
Arithmetic tags are used to perform mathematical operations on tags that already reside within Data Manager.
The arithmetic expression is written using normal mathematical syntax where the involved tags are enclosed by square
brackets. Refer to Appendix C for the complete list of available operators, functions, and constants.
Arithmetic tags can be generated based on all tags from other data sources.
The specified formula is using DPP (data preprocessing) times and DPP values from the involved tags to generate a new
raw value for the arithmetic tag.
As you want the arithmetic calculation to be based on data from the most recent cycle, you must be very careful when
you define source index and tag index.

Evaluate arithmetic algorithms
Until the value or status of an arithmetic tag change, the measurement is valid and the value constant. Arithmetic tags
are used to perform mathematical operations on tags that already reside within Data Manager.
The resulting time series change value every time there is a change in one of the involved data tags.
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Extract algorithm tag - Reduction
Reduction tags are used to reduce an existing tag in Data Manager to specific base classed defined in Data Manager.

Available reductions
Expression

Syntax and Definition

Comments

TSAvg

TSavg(['Tag'], 'Period', 'Time Assignment')

Used to calculate average or

Time series of the tag reduced to average values using
equidistant time series.

extreme values at fixed times,
for example every full hour,
every half hour, or every 10
minutes (at nice rounded time
intervals).
This method is called static
reduction.

TSMin

TSmin(['Tag'], 'Period', 'Time Assignment')
Time series of the tag reduced to minimum values
using equidistant time series.

Used to calculate an average
value at the preprocessing time
for a defined interval (period)
while retrieving data for a certain time interval back in time
(time assignment).
This method is called dynamic
reduction.
Example:
TSrun([Tag], '60', '30') where
you in 30 minutes will run a 60
minute interval.

TSMax

TSmax(['Tag'], 'Period', 'Time Assignment')

Same as for TSMin.

Time series of the tag reduced to maximum values
using equidistant time series.
TSRun

TSrun(['Tag'], 'Period', 'Time Assignment')

Same as for TSMin.

Running average of the tag.
Time Assignment' values are "L", "C" and "R", which indicate if the reduced data time tag will be justified left, center or
right of the reduction interval.
You are recommended to study to the topic About Data Tags, page 24 that provides in-depth information on reduction
tags.
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Evaluate reduction algorithms
Static reductions

The time line is divided into intervals, as specified in
the reduction interval, starting at the nearest Monday
morning at 00:00.
At each interval the minimum, maximum, or average
is deducted according to the selected reduction formula.
The reduced value for a specific period will then be
assigned to the left, right or center time of the interval
according to the last parameter given in the reduction
expression.
See figure A.

Dynamic reductions

A time interval is located based on actual preprocessing
time plus an offset and a period from this point. At this
interval the average is calculated and assigned to the
preprocessing time.
See figure B.
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Figure A

Figure B
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Appendix A: Data Configuration File
Data configuration files can be imported into or exported from the database. The files must be configured according to
the definitions in the ensuing table.
A. The first data line is a header line displaying each column name as text.
B. Lines starting with a number sign (#) or an exclamation point (!) are ignored during import. Such lines are used
for specifying comments.
C. All text must be enclosed in double quotes (").
D. Semicolons (;) separate all data.
E. For data type Yes/No - 1 represents Yes and 0 represents No.
Name

Type

Size

Description

ScadaID

Text

80

The unique name of the SCADA tag.

ScadaRef

AutoNumber

Long Integer

Unique reference number

DataSourceID

Number

Long Integer

Reference to Data Source.

ExtratMethodID

Number

Integer

Reference to Extract Method.

sSQL

Memo

SudStatusID

Number

Integer

Reference to SCADA tag status.

DataTypeID

Number

Integer

Reference to measurement type.

ConvFac

Number

Double

Reference to measurement type.

Offset

Number

Double

Offset to add after multiplication with conversion factor.

ApplyAbsCritera

Yes/No

Data Extract string (SQL statement, Parser
expression, Reduction formula) that
extract data for SCADA tag.

Defined if absolute range check is enabled
or disabled.

MinValue

Number

Double

Minimum acceptance value for measurement.

MaxValue

Number

Double

Maximum acceptance value for measurement.

ApplyChangeCriteria

Yes/No

MinChange

Number

Double

Minimum allowed change for raw value to
be accepted.

MaxChange

Number

Double

MAximum allowed change for raw value to
be accepted.

EmulationMethodID

Number

Integer

Minimum allowed change for raw value to
be accepted.

DefaultValue

Number

Double

Default value of measurement.

AveragingCycles

Number

Integer

Number of data used for running averaging.

SubstituteScadaID

Text

80

Reference SCADA tag.

SubstituteFactor

Number

Double

Factor for substitute SCADA tag.

SubstituteOffset

Number

Double

Offset for substitute SCADA tag.

Apply the change criteria?
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Name

Type

Size

Description

SaveHist

Yes/No

HistDt

Number

SaveDataPacks

Yes/No

Save all original data packs.

UpdateOPC

Yes/No

Update OPC client for this tag after DPP
cycle.

yCoordinate

Number

Double

ConversionType.

YCoordinate

Number

Double

CyclicMax.

zCoordinate

Number

Double

DataInsertMode.

Comment

Memo

DensityPeriod

Number

Integer

For Arithmetic tags only. Defines the period
within which there must be data for the tag
to be calculated.

SubstituteBufferID

Text

80

Reference buffer.

ApplyRateChangeCriteria

Yes/No

MinRateChange

Number

Double

Minimum allowed rate of change for raw
value to be accepted.

MaxRateChange

Number

Double

Maximum allowed rate of change for raw
value to be accepted.

HistoricalPeriod

Number

Integer

Number of days of history to save.

ChangeCheckPeriod

Yes/No

Perform Change check in percent.

RateChangeCheckPercent

Yes/No

Perform Rate of Change check in percent.

ApplyAgeCriteria

Yes/No

Apply the age checkcriteria?

MaxAge

Number

Long Integer

Maximum allowed age of latest value in minutes.

TagIndex

Number

Long Integer

Index which control the processing order of
the data tags.

OPCSendSourceID

Number

Long Integer

OPC Source to update to.

OPCSendTag

Text

80

OPC Tag to update to.

Save historical data for tag.
Long Integer

Time interval between historical values in
seconds.

Additional information.

Apply the absolute rate of change criteria?
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Appendix B: Historical Data File
The historical data file contains log data and other time series data that can be imported to the database. This data is formatted in a specific way as illustrated in the ensuing table.
A. All data is separated by semicolon (;).
B. The first data line is a header line containing “TIME” and the relevant number of SCADA unit names as texts. See
the format specifications in the following .
C. Lines that start with a number sign (#) or an exclamation point (!) are ignored during import. Such lines are used
for specifying comments.

Header line format
Name

Type

Size

Description

TIME

Date/Time

8

Time tag for data line.
Must have the format “DD-MM-YYYY HH:MM”

‘SCADA unit 1’

Single

8

Measurement value for the first SCADA unit.

.....

.....

.....

.....

‘SCADA unit N’

Single

8

Measurement value for the Nth SCADA unit.

Example
The following is an example of how to specify logged data line files.
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Appendix C: Arithmetic Expressions
The arithmetic expressions recognize the mathematical and physical operators, functions, and constants listed in the
tables C-1, C–2, and C–3.

C-1: Arithmetic operators
Operator

Description

+

Addition

-

Subtraction

*

Multiplication

%

Percentage

\

Integer division

^

Raise to power

||

Absolute value

!

Factorial

<

Greater than

>=

Greater than or equal

<

Less than

<=

Less than or equal

=

Equal

<>

Not equal

and

Logic and

or

Logic or

xor

Logic exclusive - or

nand

Logic nand

nor

Logic nor

nxor

Logic exclusive -nor

C-2: Arithmetic functions
Operator

Description

abs(x)

Absolute value

atn(x), atan(x)

Inverse tangent

cos(x)

Cosine

sin(x)

Sine

exp(x)

Exponential

fix(x)

Integer part, no rounding

int(x)

Integer part, rounding

dec(x)

Decimal part

ln(x)

Logarithm natural
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Operator

Description

log(x)

Logarithm decimal

md(x)

Random

sgn(x)

Sign

sqr(x)

Square root

cbr(x)

Cube root

tan(x)

Tangent

acos(x)

Inverse cosine

asin(x)

Inverse sine

cosh(x)

Hyperbolic cosine

sinh(x)

Hyperbolic sine

tanh(x)

Hyperbolic tangent

acosh(x)

Inverse hyperbolic cosine

asinh(x)

Inverse hyperbolic sine

atanh(x)

Inverse hyperbolic tangent

root(x;n)

Nth root

mod(a;b)

Integer division remainder

fact(x)

Factorial

comb(n;k)

Combinations

perm(n;k)

Permutations

min(a;b)

Minimum of two numbers

max(a;b)

Maximum of two numbers

mcd(a;b), gcd(a;b)

Maximum common divisor of two numbers

mcm(a;b), lcm(a;b)

Minimum common multiple of two numbers

erf(x)

Error - Gauss'

gamma(x)

Gamma

gammaln(x)

Logarithm gamma

digamma(x)

Digamma

beta(x;y)

Beta

zeta(x)

Zeta, Reimenn's

ei(x)

Exponential integral

csc(x)

Cosecant

sec(x)

Secant

cot(x)

Cotangent

acsc(x)

Inverse cosecant

asec(x)

Inverse secant

acot(x)

Inverse cotangent

csch(x)

Hyperbolic cosecant

sech(x)

Hyperbolic secant
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Operator

Description

coth(x)

Hyperbolic cotangent

acsch(x)

Inverse hyperbolic cosecant

asech(x)

Inverse hyperbolic secant

acoth(x)

Inverse hyperbolic cotangent

rad(x)

Radiant conversion

deg(x)

Degree (90 0) conversion

grad(x)

Degree (100 0) conversion

round(x;d)

Rounding with 'd' decimals

C-3: Arithmetic constants
Operator

Description

Note

h#

Planck

6.6260755e-34 Js

K#

Boltzmann

1.380658e-23 J/K

q#

Elementary charge

1.60217733e-19 C

A#

Avogadro

6.0221367e23 mol-1

c#

Speed of light

2.99792458e8 m/s

mu#

Permeability of vacuum

12.566370614e-7 T²m³/J

eps#

Permittivity of vacuum

8.854187817e-12 C²/Jm

me#

Electron rest mass

9.1093897e-38 kg

mp#

Proton rest mass

1.6726231e-27 kg

mn#

Neutron rest mass

1.6749286e-27 kg

R#

Gas constant

8.31451 m²kg/s²k mol

G#

Gravitational constant

6.672e-11 m³/kg s²

g#

Acceleration due to gravity

9.80665 m/s²
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Appendix D: Examples of Data Extract Results
A

Tag name:

TO_ForecastAgeHours.

Extracted data:

Age of the last simulation in hours as a measurement and will subsequently assign
the value to current time (system time of the time of the extract).

B

Tag name:

TO_NextDayProduction.

Extracted data:

The tag contains the total production for the coming day. It extracts the
total production for one plant for the coming day (24 hours) in [Wh]. Use the
conversion factor to convert to another unit. In addition if there is more than
one plant in a model, it is recommended to make one tag for each plant and
also create one tag for the entire model, and subsequently merge several
plants by adding extra OR clauses on the Name field.
To avoid having old values be present in the new forecast, you must configure the data tag option Replace under the Other tab page. For details see
About Data Tags, page 24.
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C

Tag name:

TO_Prognose.

Extracted data:

Temperature forecast for one plant as a time series with hourly values in [K].
Use the conversion offset to convert to [°C]. Create a tag similar to this for
each plant in the model. This tag will be updated dynamically as each extract
will overlap the previous and the time tags that are overlap will be updated
accordingly. As a consequence of this the tag must be configured to save history.

D

Tag name:

TO_TS.00.

Extracted data:

Optimized temperature for the current hour for one plant in [K]. Use the conversion offset to convert to [°C]. If it is required to display for example the
optimized temperature for 1 hour ahead, 2 hours ahead, etc., then create
more tags similar to this and change the Tindex parameter to the required
offset into the future. TO_TS.00 must be configured to save historical data,
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whereas it is not beneficial to save history for tags with higher Tindex.
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Appendix E: Microsoft Text Driver for ODBC
This topic describes how a text file is imported into Data Manager using a Microsoft Text Driver for ODBC, which includes
the defining of a database schema in a schema.ini file.
The text file illustrated in the ensuing figure can be treated as a table.

l

The first row in the text file encompasses field names.

l

Semi-colon is used as field separator.

l

Period is used as decimal sign.

You must configure the ODBC driver to do the translation.
The basic principle when using a Microsoft Text Driver for ODBC is to consider a folder as the database, and the files in
the folder as the tables in the database.
The database (folder) must contain a descriptor for the database structure (the database schema) that describes which
files to be treated as tables and how to treat them as tables. The database schema is saved in another text file schema.ini in the database. With reference to the figure in the preceding the database will look as shown in the following figure.

Add new sections for each text file that needs to be treated as a table.
For a complete description of the Microsoft Text Driver for ODBC and the schema.ini file you are referred to the following
Web site:
http://msdn.microsoft.com/en-us/library/ms709353(VS.85).aspx (last visited August 2010)

Add new data source
1. From the Control Panel select Administration Tools and then Data Source (ODBC).
2. Under the dialog ODBC Data Source Administrator select Add and point to Microsoft Text Driver.
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3. Under the dialog ODBC Text Setup enter the Data Source Name (in this example PrognosisData) and select
the button Select Directory to specify the file folder location. You must clear the check box Use Current Directory to access the dialog.

The new ODBC DSN now treats the selected folder as a database, and the schema.ini file in that folder defines
how the files must to be treated as database tables.

Retrieve prognosis data from text files
In this section you will learn how to create and configure a standard data source pointing to the text file ODBC database.
1. Create a new data source in Data Manager as shown in the ensuing figure.
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2. Create data tags for this data source in the exact same way as for any other OLE DB source using SQL SELECT
statements.

The default SQL is used as a template string for the specific SQL because the name of the tag is not identical to
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the field name in the database (text file).
3. To ensure that the original packets can be retrieved from Data Manager at any point in time you must select the
check box Store data in packets.
Select the tab page Other and under Historical data select the check box for Store data in packets.
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Appendix F: Heartbeat Information
This topic describes three heartbeat tags that are configured in Data Manager and returned to SCADA. These heartbeats
can subsequently be used when evaluating the quality of the setpoints.
l

Alive counter

l

Simulation age

l

Load prognosis age

When the simulation process f in Operations is activated it automatically runs cyclically (real-time) with a predefined
interval. This interval is typically from 15 minutes to 2 hours depending on the size and complexity of the model. After
each successfully completed simulation cycle, Operations pauses and wait for the next cycle to start. This means that
the results are renewed with the same frequency as the simulation. The results file typically contains 24 hours of data
from the start of the simulation and onwards. This means that Data Manager can continue to send varying optimized
supply temperatures to SCADA for 24 hours and after that it will keep on sending the last available value.
If for some reason Operations cannot find any solution in a cycle, or the real-time cycle is stopped, then the results file
will not be renewed. The results that are sent to SCADA now come from a simulation that is considered to be outdated.
To evaluate the age of the last simulation the tag displayed in the ensuing figure must be configured in Data Manager.
Tag containing the age of the last simulation.

The data source is the product default Microsoft Access link database that links to the TERMIS ODBC result database.
This tag will contain the age of the last simulation in full hours. By setting an upper limit for this tag in SCADA, it will be
possible to suppress the temperature optimization supply temperatures as long as this tag exceeds the limit defined.
Data Manager is typically set to transfer new data from the last simulation process for temperature optimization in TERMIS Operation at a frequency lower than the simulation cycle, for example every 10-30 minutes.
To check that the communication from Data Manager to SCADA is working, a ‘life signal’ tag can be implemented as
shown in the ensuing figure.
Tag containing an incrementing life signal for the data communication.
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You must create an internal algorithm data source for this tag in Data Manager. This tag will then start at zero and keep
on incrementing by one at each Data Pre-Processing (DPP) cycle in Data Manager until it reaches a maximum value (in
this case 1,000) and resets to zero and starts all over again. By setting a time limit for this tag in SCADA, it will be possible to suppress the calculated setpoints, provided this tag has not changed within the defined time limit.
To instantiate this tag it is important to set the status to One default used. The DPP will automatically change this status
to Used directly after the first DPP cycle and at the same time set the default value on the Emulation tab to zero.
When Operations performs meteorological forecast simulations it uses either a load forecasts (zone based) or meteorological forecasts for temperature and wind as input to a degree day model to predict the future production. Such prognosis time series are normally supplied every 4-24 hours.
To evaluate the age of the last received prognosis the tag shown in the ensuing figure must be configured in Data Manager.
Tag containing the age of the last received prognosis.

Tag containing the age of the last received prognosis
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In this configuration case is a meteorological forecast delivered in a simple text file which is accessed via ODBC using
Microsoft Text Driver. For details on the setup of the text driver see Appendix E: Microsoft Text Driver for ODBC, page
109. Notice that not all ODBC drivers or OLE DB providers support the DateDiff function.
This tag contains the age of the most recent weather prognosis file in full hours.
When you set an upper limit for this tag in SCADA it will be possible to suppress the temperature optimization supply
temperatures as long as this tag exceeds the defined limit.
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Appendix G: SQL Substitution Rules
This appendix provides guidelines for the SQL substitution rules.
l

Only available for SQL extract statements for Data Manager data sources.

l

Used to specify certain keywords or parameters in the SQL extract statements to facilitate Data Manager specific
needs.

l

Increase the possibilities to specify generic SQL statements on data source level.

The substitution keywords are replaced by Data Manager before the SQL extract statement is submitted to the data
source. Date keywords are replaced in the format required by the respective data source.
You can use the following substitution rules in SQL statements:
l

$TAG
Is replaced by the individual tag name.

l

$LastTime
Is replaced with the time tag of the previous measurement received for the tag in question.
If there is no previous data the value specified for Default $LastTime under the Preferences dialog (Preprocessor tab page) will apply.

l

$NOW
Is replaced by the system time.

l

$DateAdd(OFFSET)
Is replaced with system time in addition to the number of minutes specified for OFFSET. Any integer is accepted
as OFFSET.

SELECT TimeTag, dValue, StatusID FROM Data WHERE Object = '$TAG' AND TimeTag > $LastTime AND
TimeTag < $DateAdd(-10)

SQL date and time formats
There is no consistent standard for date and time formats across database engines and that often gives rise to errors.
When you use the $LastTime substitution rule, there is a full substitution; including the time stamp format for the specified database.

Microsoft Access
#YYYY-MM-DD HH:MM:SS#

Microsoft SQL Server
”YYYY-MM-DD HH:MM:SS”
CONVERT(DATETIME, YYYY-MM-DD HH:MM:SS ', 102)

ODBC
{ts 'YYYY-MM-DD HH:MM:SS'}

Oracle
TO_DATE('YYYY-MM-DD HH:MM:SS', 'YYYY-MM-DD HH24:MI:SS')
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Note
Never use DD-MM-YYYY in SQL statements as it is read and interpreted as MM-DD-YYYY.
For example: 01 March 2010 is read as 03 January 2010.
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Appendix H: Data Preprocessor Flow
The following chart shows how for each data preprocessor cycle there is an evaluation of the raw data by performing a
series of checks on raw status and raw value.

For each cycle, the time of the most recent SCADA unit is saved as a time tag for all the data within the cycle. This is
referred to as a data group or a data set.
When the preprocessor is enabled, it only processes data from SCADA units that are not defined as disabled/inactive. If
no new measurements have been received since the last cycle, the current preprocessing cycle is canceled.
See About Preferences - Initial Configuration, page 10.
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Appendix I: Data Flow (for Data Tags)
The ensuing diagram provides an overview of the data flow in connection with data checks and data emulation.

Checks
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Emulation
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Appendix J: Toolbar Buttons and Shortcuts
The toolbar in the upper part of the screen is an integrated part of the Data Manager user interface and is always displayed. The buttons are shortcuts to some of the most commonly used features.
Menu

Description
Click this button to open the Preferences dialog box.
Click this button to open the Data Sources dialog box.
Click this button to open the Data Tags dialog box.
Click this button to open the Measurements dialog box.
Click this button to open the Historical Data dialog box.
Click this button to open the Data Graph dialog box.

Click this button to open the Preprocessor dialog box.
Click this button to toggle scheduled import of time series on and
off. This button is only available if you have defined one or more
intervals in the Scheduler area in the Import Time Series dialog
box.
To open the Import Time Series dialog box
Click the File menu, point to Import, and then click Time
Series.
Click this button to view the Data Manager documentation.

Shortcuts
This topic provides a list of shortcuts to use when you edit.

Keyboard shortcuts
View keyboard shortcut keys…
Shortcut Key

Description

CTRL+A

Select All controls.

CTRL+C

Copy selected controls to clipboard.

CTRL+V

Paste contents of clipboard (controls).

CTRL+X

Cut selected controls to clipboard.

ESC

Deselect all currently selected controls.
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Shortcut Key

Description

RETURN

Open properties on selected controls.

TAB

Tab to next control in the tab order.

SHIFT+TAB

Tab to previous control in the tab order. (When tab index is the
same it uses control order top to bottom and then left to right.)

DELETE

Delete selected controls.

LEFT CURSOR

Move selected controls 1 point to the left. (If snap is selected to
the nearest grid position.)

RIGHT CURSOR

Move selected controls 1 point to the right. (If snap is selected to
the nearest grid position.)

UP CURSOR

Move selected controls 1 point up. (If snap is selected to the nearest grid position.)

DOWN CURSOR

Move selected controls 1 point down. (If snap is selected to the
nearest grid position.)

CTRL+LEFT CURSOR

Align left edges of selected controls (to the main selected control
indicated by white selection handles).

CTRL+RIGHT CURSOR

Align right edges of selected controls (to the main selected control
indicated by white selection handles).

CTRL+UP CURSOR

Align top edges of selected controls (to the main selected control
indicated by white selection handles).

CTRL+DOWN CURSOR

Align bottom edges of selected controls (to the main selected control indicated by white selection handles).

SHIFT+LEFT CURSOR

Reduce width of selected controls by 1 point.. (If snap is selected
to the nearest grid position).

SHIFT+RIGHT CURSOR

Increase width of selected controls by 1 point. (If snap is selected
to the nearest grid position).

SHIFT+UP CURSOR

Reduce height of selected controls by 1 point. (If snap is selected
to the nearest grid position.)

SHIFT+DOWN CURSOR

Reduce height of selected controls by 1 point. (If snap is selected
to the nearest grid position.)

F9

Align the vertical centers of the selected controls to that of the
main selected control.
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Mouse shortcuts
View mouse shortcuts…
Shortcut Key

Description

DOUBLE CLICK - selected con-

Open properties on selected controls.

trols
DOUBLE CLICK - dashboard

Open properties of dashboard.

background
DRAG - selected controls

Move selected controls (if snap is selected to nearest grid position.)

DRAG - selection handles

Resize selected controls (if snap is selected to nearest grid position.)

RIGHT CLICK -selected controls

Show relevant context menu for selected controls.

RIGHT CLICK - dashboard back-

Show relevant context menu for dashboard.

ground
LEFT CLICK - selected controls

Makes relevant control the main selected control for format commands.

CTRL+LEFT CLICK

Select or cancel the selection for an individual control.

SHIFT+LEFT CLICK

Test run event assigned to control.
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